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1 Introduction 
This tutorial takes you through the process of building a realistic predictive model using 
AgenaRisk. In the process of building this model, you will learn about the more advanced and 
powerful features that AgenaRisk has to offer. You will also gain modelling experience that 
you can later apply to your own problems.  
 
Before working through this tutorial you should read the basic tutorial called Getting Started 
with AgenaRisk to ensure that you understand how to use the common features of 
AgenaRisk. 
 
Throughout this tutorial, various formatting conventions are used: 
 

File A term appearing in bold will sometimes refer to a menu on the 
toolbar that you are required to select. 

OK Bold is also used to indicate any button that you are required to 
click. 

23 Bold can be used to indicate any value that you are asked to 
enter or select. 

Menu → Menu Item 
Two or more bold terms separated by an arrow indicate a path 
from a toolbar menu (or from the Start menu) down to a menu 
item that you are required to click. 

Ctrl + W 
The use of Ctrl, Alt or Shift in conjunction with a + symbol and a 
letter indicates that the key should be pressed down 
simultaneously with the letter to invoke a particular function. 

Filename.ast Names of files and directories (used during opening, saving and 
importing) are indicated by italics.  

Directory / Filename.ast 
Two or more italicised terms separated by a forward slash 
indicate a path from a directory (or folder) down to a particular 
file. 

  This icon indicates a tip or other piece of useful information. 

  
This icon indicates a warning; you should pay particular 
attention to these. 

 
Table 1 Formatting conventions 
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2 Introducing the Car Costs Model 
1. You want to predict the running costs of a new car. You have short-listed three 

different makes of car: Mercedes, Honda and Ford. You want to find out which of 
these is going to be cheapest to run over time.  

 
2. The important variables under consideration are: 

 
• Car type (small, medium or large) 
• Reliability (which impacts on maintenance cost) 
• Fuel economy (miles per gallon) 
• Fuel price 
• Annual mileage 
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3 Building the Car Costs Model 

3.1 Creating Ranked Nodes 
1. Start AgenaRisk and create a new model by selecting Create New Model from either 

the opening dialog or the File menu. Alternatively, you can click on the new model 
icon on the toolbar: 
 

 
 
2. If it is not already selected, toggle the auto-calculate button on the toolbar: 

 

 
 
3. Expand the Risk Explorer and select the item called New Risk Object. There will be 

only one Risk Object in this model. Notice that the Risk Object is flagged with a red 
icon: 

 

 
 
You will see this icon in various parts of the AgenaRisk interface. It means that a 
calculation must be run on the Risk Object in question in order to make it consistent. 

 
4. Right-click on the New Risk Object and select Rename. In the dialog that appears, 

type Car Costs and click OK. 
 
5. Create a new node in the top left corner of the Risk Map. Change its name to Car 

Type, change its type to Ranked, change its unique identifier to car_type and then 
click Apply. Your dialog should look like the one shown in Figure 1 below: 

 

 
 

Figure 1 Node Details for Car Type node 
  

Changing the unique identifier to something short yet meaningful is important 
because, later on, this node will be used in expressions. 
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6. Click on the Node States Tab. In the Type field in the middle of the dialog, choose 

Low -> High (3). Then, in the States text box, replace the values Low, Medium and 
High with Small, Medium and Large.  

 
7. Click Apply and then click on the Appearance tab. 

 
8. Select the rounded rectangle at the top of the dialog, change the background colour 

to dark blue and click Apply. (The colour scheme is arbitrary but, in this model, we 
are going to use dark blue for nodes where the user has to make a choice, medium 
blue for nodes relating to cost and dark blue for nodes containing assumptions. 
Colour coding nodes can make models more user-friendly.) 

 
9. Click on the Text Format tab. 

 
10. Change the font size to 12, change the text colour to white and then click OK. 

 
11. Your node should now look like this: 

 

 
 

Figure 2 Car Type node after editing 
 

12. Copy the Car Type node and paste the copy to the right of Car Type on the Risk Map. 
 
13. Change the properties as follows: 

 

Node Name Reliability 

Unique Identifier reliability 

States High -> Low (3) (leave the states as High, Medium and Low) 

Background Colour Light Blue 

Text Colour Black 

 
Table 2 Properties for Reliability node 

 
14. Your two nodes should now look like this: 
 

 
 

Figure 3 Risk Map after adding Reliability node 
 

15. Copy the Reliability node and paste it on to the Risk Map beneath the two existing 
nodes and change the properties as follows: 
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Node Name Maintainability 

Unique Identifier maintainability 

Background Colour Medium Blue 

 
Table 3 Properties for Maintainability node 

 
16. Draw edges from Car Type to Maintainability and from Reliability to Maintainability. 

This captures the information that Maintainability is influenced by both Car Type and 
Reliability. 

 
17. Your Risk Map should now look like the one shown in Figure 4 below. 

 

 
 

 Figure 4 Risk Map after adding Maintainability node and edges 

3.2 Using Weighted Expressions 
1. Currently, the model shows the causal relationships between the three nodes, Car 

Type, Reliability and Maintainability, but for these relationships to be of any use you 
need to define the Node Probability Table (NPT) of the Maintainability node.  

 
2. Right-click on the Maintainability node, bring up the properties dialog and click on the 

Node Probability Table tab. 
 

3. Rather than defining the NPT manually, we are going to make life simpler and use an 
expression that will, behind the scenes, generate the NPT automatically. In the NPT 
Editing Mode drop-down box, select the value Expression. The expression editor 
will appear in the dialog as shown in Figure 5 below. 
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Figure 5 Expression editor for Maintainability node 
 

4. Click on the Expression Type drop-down box and observe that only two types of 
expression are available for ranked nodes: TNormal and Arithmetic. We will deal 
with Arithmetic expressions later. For now, leave the type set to TNormal. 

 
5. TNormal is short for “Truncated Normal”. This is a Normal distribution where the two 

ends are cut off or truncated. When the TNormal distribution is used with Ranked 
nodes, it is always truncated using the values 0 and 1. This is because Ranked nodes 
are all mapped on to an underlying scale of 0 – 1. 

 
6. You are now going to create a weighted expression that defines the parameters of 

the TNormal distribution. This weighted expression will reflect the relative strength of 
influence that the two nodes, Car Type and Reliability, have on Maintainability.  

 
7. Right-click anywhere in the Mean text box and choose Insert weight expression → 

WeightedMean.  
 

8. You will see a dialog like the one shown in Figure 6 below. 
 

 
 

Figure 6 Dialog for eliciting weighted expression 
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9. This dialog allows you to select which parents you want to include in the weighted 

expression and what weighting you want to give them. The slider bar at the top lets 
you specify how much certainty you have about this weighting. Complete the dialog 
so that it looks like the one in Figure 7. In this case, the expression says that when 
defining the maintainability of a car, we are moderately certain that car type is twice 
as important as reliability. 

 

 
 

Figure 7 Weighted expression dialog for Maintainability node 
 

10. Click OK. The expression editor should now look like this: 
 

 
 

Figure 8 Expression editor after defining a weighted expression 
 

11. You can see that the level of certainty you specified using the slider bar in the 
weighted expression dialog is used as the variance for the TNormal distribution. The 
mean of the TNormal is a formula based upon your choice of parent nodes and their 
weights. Note that the unique identifiers of the parent nodes are used in the formula 
rather than their names. 

 

 
If you want to edit this expression in future (e.g. if you want to change the 
weights or variance), you can right-click on the Mean text box and select Insert 
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weight expression → WeightedMean. The existing values will appear in the 
weighted expression dialog and you can modify them. However, you may find it 
quicker to edit the variance and mean text boxes by hand. 

 
12. Click on Apply. This generates the underlying NPT.  
 
13. You can inspect the NPT that has been created by selecting the value Manual in the 

NPT Editing Mode drop-down box. Scroll around the table and look at the values in 
each of the cells. When you are finished, set the value of the NPT Editing Mode 
drop-down box to Expression. 

 
14. Click OK. 

 
15. Now you can test this model fragment. Click on the calculate button on the toolbar: 

 

 
 

 

Whenever you generate (or regenerate) an NPT, you will need to run a manual 
calculation immediately afterwards even if you have the auto-calculate feature 
switched on. Automatic calculation only happens after you remove or enter 
observations. 

 
16. Notice that the red icon has now disappeared from the Risk Object in the Risk 

Explorer. This means that a calculation has been executed and that the model is in a 
consistent state. 

 
17. Double-click on all three nodes on the Risk Map so that their Risk Graphs appear. 

Resize the nodes so that you can see the graphs in their entirety. Your Risk Map 
should like the one in Figure 9. 

 

 
 

Figure 9 Car Type, Reliability and Maintainability after calculation 
 

18. The Maintainability Risk Graph tells us that, when we know nothing at all about 
Reliability or Car Type, it is most likely that Maintainability will be Medium.  

 
19. Try entering different observations for both Car Type and Reliability and notice how 

the probability distribution of Maintainability changes. Verify, in particular, that when 
Car Type is Small and Reliability is Low, Maintainability is skewed towards High. 
This illustrates the increased weighting you gave to Car Type. 
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20. You should also look at the effects of so-called “back propagation”. Clear any 

observation you may have entered on Car Type or Reliability and enter the 
observation High for Maintainability. Note that the other two distributions both change 
– Car Type moves towards Small and Reliability moves towards High – but Car Type 
is more skewed. In other words, if all we know about a car is that its Maintainability is 
high, then the most likely explanation is that the car is small. Now enter the 
observation Large for Car Type. The distribution for Reliability changes dramatically; 
we are now almost certain the Reliability must be high. 

 
21. Before continuing, select Tools → Clear Entered Data → All and click OK in the 

confirmation dialog. 
 

22. Now save your model. 

3.3 Using Partitioned Expressions 
1. Create a new node beneath Car Type on the Risk Map. Move the existing nodes to 

create space as required. 
 
2. Draw an edge from Car Type to the node you just created. 

 
3. Bring up the properties dialog for the new node. Change the node’s name to Miles 

per Gallon, change the unique identifier to mpg and check the box marked 
Simulation Node. By making the node a simulation node, you are telling AgenaRisk 
to dynamically calculate the optimum set of states that the node should have. 

 
4. Click Apply and then click OK on the information pop-up that appears. (The pop-up 

appears because you have made the node a simulation node before defining an 
expression. Simulation nodes need expressions. The message indicates that a 
default expression has been created for you.) 

 
5. In the Appearance tab, change the background colour of the node to light blue and 

change its shape to being a rounded rectangle.  
 

6. Click Apply. 
 

7. Click on the Node States tab. You will see that, by default, this node (of Continuous 
Interval type) has five states: 0.0 – 10.0, 10.0 – 20.0, 20.0 – 30.0, 30.0 – 40.0 and 
40.0 – 50.0.  

 
8. Because this node is a simulation node, we only need to specify one large interval. 

This interval will then be divided up intelligently during calculation. Click on the 
Remove All States hyperlink. This will leave just one state, 0.0 – 10.0.  

 
9. Edit the lower bound and upper bound to be 5 and 100 respectively. The state editor 

should now look like this: 
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Figure 10 State editor showing single state 
 

10. Click Apply. 
 

11. Now click the Node Probability Table tab on the left of the dialog. This initially 
displays the Uniform expression that was automatically created when you made this 
node a simulation node earlier. 

 
12. In the NPT Editing Mode drop-down box, select Partitioned Expression. Partitioned 

expressions are very powerful. They allow us to generate an NPT using a different 
expression for each combination of parent states. In this case we can specify a 
different distribution of miles per gallon for a small car, for a medium car and for a 
large car. This accurately reflects the real world; one distribution for miles per gallon 
wouldn’t be sufficient to capture these differences. 

 
13. Select Car Type in the left-hand list and click the Add > button to move it to the right-

hand list. This is how we indicate that we want to supply different expressions for 
each state of the parent node Car Type. Notice that there are now three cells in the 
table below the two lists, one for each state of Car Type.  

 
14. Double-click on the first cell. An expression entry dialog appears. In the Expression 

Type field, select TNormal. Fill out the parameters so that the dialog looks like that 
shown in Figure 11. 
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 Figure 11 Partitioned expression entry dialog 
 

15. Click OK. Notice that the TNormal expression now appears in the first cell in the 
table.  

 
16. Complete the other two cells in the same way with TNormal expressions. For both 

expressions, specify the Lower Bound to be 5 and the Upper Bound to be 100. For 
the expression in the Medium cell, specify 28 as the Mean and 50 as the Variance. 
For the expression in the Large cell, specify 18 as the Mean and 30 as the Variance. 
This partitioned expression now represents our view that larger cars are less fuel-
efficient than smaller cars. 

 

 

The quickest way of completing multiple cells with a very similar formula is to 
use copy and paste. Right-click on a completed cell and select Copy, then 
right-click into all the other cells and click Paste. Each cell is now identical. 
Then double-click on each cell to modify it. 

 
17. Click OK. 

 
18. Run a calculation by clicking the calculate button on the toolbar. 

 
19. Double-click on the Miles per Gallon node. Recall that you only specified one state for 

this node. You can now see how simulation has created a number of states 
automatically. Make the node larger so you can see all the states. 

 
20. Hold your mouse over some of the bars on the graph and notice the information that 

is available.  
 

21. This information is also available on the Risk Graph Panel. Look at the window on the 
Risk Graph Panel marked Miles per Gallon. Click on the Expand State List 
hyperlink. You will now see a full list of the states and probabilities that exist on this 
node. (You will need to scroll down to see all of them.) 

 

 

If you are displaying Risk Graphs on the Risk Graph Panel rather than on the 
Risk Map, you can still access the information summary by dragging the 
separator bar on the far left of the graph to the right so that the window splits. 
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3.4 Customising Risk Graphs 
1. Because the intervals of each state are not equal, the Miles per Gallon Risk Graph 

takes on a slightly jagged appearance as shown in Figure 12.  
 

 
 

Figure 12 Default Risk Graph for Miles per Gallon node  
 
2. In cases like this, where you have a continuous scale that has been divided up into 

unequal intervals during simulation, it is best to change the way the Risk Graph is 
plotted.  

 
3. Right-click on the Miles per Gallon node and select Risk Graph → Graph 

Properties from the pop-up menu.  
 

4. Check the Continuous X-Scale box. 
 

5. Click on the All Datasets tab and in the Graph Type drop-down box, select Line. 
 

6. Click OK. The resulting graph is now a much smoother curve as shown in Figure 13.  
 

 
 

Figure 13 Continuous Risk Graph for Miles per Gallon node 
 

To view the details of any point plotted on the graph, just move your mouse over it. 
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7. The changes you just made to the Risk Graph properties are only temporary. Close 
the Risk Graph by right-clicking on it and selecting Risk Graph → Close Risk 
Graph. When you re-open the Risk Graph (by double-clicking on the node), it will 
look like it did originally. For this reason, it is better to specify these properties on the 
node itself. Then, whenever a Risk Graph is shown for the node, it will have the same 
attributes. Even more usefully, Risk Graph properties can be specified for the whole 
model. In this way, a set of defaults can apply to all Risk Graphs that are created. 

 
8. The Risk Graph properties system is complex but powerful. It works hierarchically. 

You specify a set of defaults at the model level. These will apply in all cases except 
for those nodes in which you choose to override them. Then, for a given node, you 
can temporarily change the way its Risk Graph is plotted by changing the temporary 
properties on the Risk Graph itself. 

 
9. Close down the Miles per Gallon Risk Graph again (since model-level and node-level 

properties do not affect any Risk Graphs that are currently being displayed) and then 
select File → Model Properties from the menu bar.  

 
10. In the Graph type for large data set drop-down box, select Line. 

 
11. Check the box marked Use a Continuous X-Axis. Click OK on the properties dialog 

and click OK on the confirmation pop-up that appears. 
 

12. Double-click on Miles per Gallon to open its Risk Graph again. Observe that the Risk 
Graph is plotted as a continuous line. 

 
13. Now let’s assume that you want the Miles per Gallon node (and only this node) to 

have its mean shown whenever its Risk Graph is displayed. 
 

14. Close down the Miles per Gallon Risk Graph again. 
 

15. Right-click on the Miles per Gallon node, select Properties and click on the Graph 
Defaults tab. You can see that the list of properties is the same as the model-level 
list. The symbol to the left of each property indicates that the property is currently 
inherited from the model and not being overridden in this node: 

 

 
 

16. Click on the inheritance symbol next to Mean in the Point Values section of the 
dialog. The symbol changes to show that the property is now going to be overridden 
(i.e. it is no longer inherited from the model level):  
 

 
 
Check the Mean box. This ensures that the mean will now always be shown on the 
Risk Graph for this node. 

 
17. Click OK on the properties dialog and on the confirmation pop-up.  
 
18. Bring up the Miles per Gallon Risk Graph. You can now see a vertical dotted line 

indicating where the mean sits in the distribution:  
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Figure 14 Risk Graph for Miles per Gallon node showing mean 

 
The mean will displayed every time you reopen the Risk Graph on this node but the 
mean will not be displayed for any other nodes. 

 
19. Enter different values for Car Type and notice how the Miles per Gallon Risk Graph 

changes. 
 
20. There are some other node-level graph properties to set before you move on. The 

first three nodes you added, Car Type, Reliability and Maintainability, should not be 
plotted continuously. Close down the Risk Graphs for these three nodes and reopen 
them. Notice that the x-axis for each graph now contains a continuous scale rather 
than the rank labels.  

 
21. To rectify this, you need to turn off continuous plotting for each node. Right-click on 

Car Type, select Properties and click on the Graph Defaults tab. Click on the 
inheritance tab next to the Use a Continuous X-Axis label, uncheck the adjacent 
box and click OK. Click OK on the confirmation pop-up that appears. 

 
22. Turn off continuous plotting for Reliability and Maintainability in the same way. 
 
23. Clear all observations and save the model. 
 
24. If you have time, try modifying the other Risk Graph properties and experiment with 

the hierarchical property system. Consult the user manual for more information about 
any properties that you don’t understand.  

3.5 Adding Constants 
1. Add a node to the Risk Map beneath Miles per Gallon and bring up its properties 

dialog.  
 
2. Modify the following properties: 
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Node Name Fuel price $ (gallon) 

Unique Identifier fuel_price 

Simulation Node Ticked 

Shape Rounded Rectangle 

Background Colour Light Blue 

 
Table 4 Properties for Fuel price $ (gallon) node 

 
3. Give the node one state with a lower bound of 0.5 and an upper bound of 10. 

 
4. Click on the Node Constants tab. Constants are numbers to which you can assign 

names so that they can subsequently be used in expressions. The power of 
constants is that their values can be modified later on via the Risk Table without 
needing to edit the expressions in which they are involved. 

 
5. Click on the insert button: 

 
 

 
6. Type fuel_price_const in the Constant Name field and type 3 in the Default Value 

field. 
 
7. Click Apply. 

 
8. Click on the Node Probability Table tab and then, in the Expression Type drop-

down box, select Arithmetic. 
 

9. Delete the 0.0 value in the Arithmetic Expression text box. 
 

10. Right-click on the Arithmetic Expression text box, select Insert constant → 
fuel_price_const and click OK. 

 
11. You have now made Fuel price $ (gallon) a constant node. This is because the node 

is a simulation node and its NPT is generated from the value of the fuel_price_const 
constant. This means that, after calculation, Fuel price $ (gallon) will have a single 
value. This value will either be the default (3) or whatever is specified in the 
corresponding Risk Table entry. 

 
12. Before the value of the fuel_price_const constant can be modified, an entry needs 

to be added to the Risk Table. Click on the Risk Table tab, right-click on the Fuel 
price $ (gallon) entry and select Properties. 

 
13. In the Connection Type drop-down box, select Constant and then click OK. The 

value of fuel_price_const can now be changed by editing the contents of this entry’s 
text box. 

 
14. Copy the Fuel price $ (gallon) node, paste it into the Risk Map and move the copy 

below the original.  
 

15. Open the properties dialog for the newly pasted node, change its name to Miles per 
Year and change its unique identifier to mpy.  

 
16. Click on Apply. 
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17. Click on the Node States tab. Check the Make upper bound positive infinity box. 
There are now two states. Change the lower bound of the first state to 0. Change the 
lower bound of the second state to 1. The two states should now be 0 – 1 and 1 – inf.  

 
18. Click on Apply. 

 
19. Click on the Node Constants tab, change the value of the Constant Name field to 

miles_per_year_const and change the Default Value to 10000. 
 

20. In the Node Probability Table tab, verify that the expression now contains the 
modified constant name, miles_per_year_const.  

 
21. Click OK. 

 
22. Look in the Risk Table and notice that a new entry has been created for 

miles_per_year_const: 
 

 
 

Figure 15 Risk Table showing entries for constants 
 

 
23. Save your model. 

3.6 Using Arithmetic Expressions 
1. Copy the Fuel price $ (gallon) node, paste the copy and place it to the right of the 

original. 
 
2. Draw edges from Fuel price $ (gallon) and Miles per Gallon to this node.  
 
3. Open the properties dialog for the copy, change its name to Price per Mile ($) and 

change its unique identifier to ppm. 
 

4. Click on the Node States tab. Change the lower bound of the single state to 0.  
 

5. Click on Apply. 
 

6. Click on the Node Constants tab. Right-click on the constant and choose Delete 
Selected. You don’t need any constants defined on this node. 

 
7. Click on the Node Probability Table tab. The expression used for generating the 

NPT of Price per Mile ($) is going to be a simple division of Fuel price $ (gallon) by 
Miles per Gallon.  

 
8. Clear the Arithmetic Expression text box and then right-click inside it. Select Insert 

parent → Fuel price $ (gallon) (fuel_price).  Then type the division symbol: /. 
Finally, select Insert parent → Miles per Gallon (mpg).  

 
9. Click OK. 

 
10. Run a calculation. 

 
11. Double-click on the Price per Mile ($) node to bring up its Risk Graph and resize it so 

that you can see it all. The graph should look like the one shown in Figure 16. 
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Figure 16 Risk Graph for Price per Mile ($) with long tail 
 

12. There is a very long tail on this distribution that isn’t of interest. You can modify the 
Risk Graph properties for just this node so that the tail isn’t displayed. This allows you 
to focus more clearly on the main area of the distribution.  

 
13. Close the Risk Graph and bring up the properties for the Price per Mile ($) node. 

Select the Graph Defaults tab. Click the override icons next to Treat Min/Max X as 
percentiles, Lower percentile X Bound and Upper percentile X Bound. Check the 
Treat Min/Max X as percentiles box, type 0.1 in the Lower percentile X Bound box 
and type 98 in the Upper percentile X Bound box. This configures the graph so that 
the first 0.1% and the last 2% of probability mass are not shown.  

 
14. Click OK on the properties dialog and on the confirmation pop-up that appears 

afterwards. 
 

15. Double-click on the Price per Mile ($) node. You should see a graph that looks like 
the one in Figure 17 below. 

 

 
 

Figure 17 Risk Graph for Price per Mile ($) after changing graph properties 
 

16. If you have time, enter different values of Car Type and observe the effects on Price 
per Mile ($). Before continuing, clear all observations. 

 
17. Create a new node below and to the right of Price per Mile ($). Draw edges from 

Price per Mile ($) and Miles per Year to this new node. 
 

18. Open the properties dialog for the new node and supply the following property values 
using the techniques you have previously learned: 
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Node Name Annual Fuel Cost ($) 

Unique Identifier afc 

Simulation Node Ticked 

Node States 0 – 10, 10 – inf 

NPT (Expression) Price per Mile (ppm) * Miles per Year (mpy) 

Shape Rounded Rectangle 

Background Colour Medium Blue 

Treat Min/Max X as 
percentiles Ticked 

Lower percentile X 
Bound 1 

Upper percentile X 
Bound 99 

 
Table 5 Properties for Annual Fuel Cost ($) node 

 
19. Run a calculation. 
 
20. Double-click on Annual Fuel Cost ($) and resize the Risk Graph so you can see all of 

it. It should look like this: 
 

 
 

Figure 18 Risk Graph for Annual Fuel Cost ($) 
 

 
Remember that you can get more screen space by decreasing the width of the 
Risk Graph panel and Risk Explorer (or by retracting them completely). 

 
21. Your Risk Map should now look something like the one in Figure 19. 
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Figure 19 Partially complete Car Costs Risk Map 
 

22. Save your model. 

3.7 Completing the Model 
1. There are now just two nodes left to add; then the Car Costs model will be complete 

and you can start using it and viewing its predictions. 
 
2. Add a node to the right of Maintainability. Make Maintainability the parent of this new 

node by adding an edge between them. 
 

3. Open the properties dialog for the new node and supply the following property values: 
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Node Name Annual Maintenance Cost ($) 

Unique Identifier amc 

Simulation Node Ticked 

Node States 0 – 600 

Background Colour Medium Blue 

Shape Rounded Rectangle 

Treat Min/Max X as 
percentiles Ticked 

Lower percentile X 
Bound 1 

Upper percentile X 
Bound 99 

 
Table 6 Properties for Annual Maintenance Cost ($) node 

 
4. The NPT is specified using a Partitioned Expression. Specify a TNormal expression 

for each state of the parent, Maintainability. 
 
5. When Maintainability is High, use a TNormal with a mean of 100, a variance of 100, a 

lower bound of 0 and an upper bound of 600. 
 

6. When Maintainability is Medium, use a TNormal with a mean of 200, a variance of 
150, a lower bound of 0 and an upper bound of 600. 
 

7. When Maintainability is Low, use a TNormal with a mean of 500, a variance of 150, a 
lower bound of 0 and an upper bound of 600. 

 
8. Run a calculation. 

 
9. Double-click on Annual Maintenance Cost ($), resize the Risk Graph and verify that it 

looks like the one in Figure 20. 
 

 
 

Figure 20 Risk Graph for Annual Maintenance Cost ($) 
 

10. Add a node below Maintainability on the Risk Map. Make Annual Maintenance Cost 
($) and Annual Fuel Cost ($) the parents of this new node by adding edges between 
them. 

 
11. Open the properties dialog for the new node and supply the following property values: 
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Node Name Total Annual Cost ($) 

Unique Identifier total_annual_cost 

Simulation Node Ticked 

Node States 0 – 10, 10 – inf 

NPT (Expression) Annual Maintenance Cost ($) (amc) + Annual Fuel Cost $ 
(afc) 

Background Colour Medium Blue 

Shape Rounded Rectangle 

Treat Min/Max X as 
percentiles Ticked 

Lower percentile X 
Bound 0 

Upper percentile X 
Bound 98 

 
Table 7 Properties for Total Annual Cost ($) node 

 
12. Run a calculation. 

 
13. Double-click on Total Annual Cost ($), resize the Risk Graph and verify that it looks 

like the one in Figure 21. 
 

 
 

Figure 21 Risk Graph for Total Annual Cost ($) 
 

14. The model is now complete. The Risk Map should look something like this: 
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Figure 22 Completed Risk Map of Car Costs model 
 

15. Save your model. In the next section, you will interact with the model and use it to 
generate predictions about the expected running costs of your three short-listed 
makes of car. 

 
16. Before proceeding to the next section you might wish to check your solution against 

the correct solution which can be found here: Examples / Tutorials / Car Costs.ast 
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4 Running the Car Costs Model 

4.1 Creating and Deleting Scenarios 
1. One of the most powerful features of AgenaRisk is the ability to compare different 

scenarios side by side. You are going to use scenarios to compare the three car 
makes on your short-list: Mercedes, Honda and Ford. 

 
2. Before continuing, turn off the auto-calculate feature by toggling the auto-calculate 

button: 
 

 
 
You will be adding and removing a lot of observations in this section of the tutorial 
and you don’t want a calculation to occur automatically after each change.   

 
3. Click on the downward arrow at the top of the screen next to Risk Scenarios: 

 

 
 

4. This expands what is known as the Scenario Manager. Currently, the Scenario 
Manager contains only one Scenario as shown in Figure 23 below. 

 

 
 

Figure 23 Scenario Manager showing one scenario 
 
When a new model is created, it has just one scenario. This scenario is active, which 
means it is displayed in the Risk Table and that observations in this scenario are 
shown on the Risk Map. In addition, the scenario is displayed on Risk Graphs.  
 

5. Click on the Scenario 1 text. You will see that it is editable. Using the Backspace key, 
remove the text and type Mercedes. 

 
6. Right-click anywhere in the Scenario Manager and choose Add a New Scenario. 

Rename this scenario Honda. 
 

7. Add another new scenario and name this one Ford.  
 

8. Click on the Risk Table tab below the Scenario Manager. Notice that the column of 
fields is called Mercedes. This corresponds to the first scenario you added.  

 
9. By default, only the first scenario in a model is marked as active. In order to see the 

other two scenarios on the Risk Table, click their Active boxes. You should now see 
all three scenarios: 
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Figure 24 Scenario Manager showing three scenarios 
 

10. Scenarios can also be deleted from the Scenario Manager. Add two new scenarios 
and then select both of them by holding down the Ctrl key between clicks.  

 
11. Right-click on the scenarios and select Delete Selected Scenario(s). Verify that the 

Scenario Manager now contains just the three scenarios created earlier. 
 

 

If you have a scenario containing a lot of observations, the quickest way of 
creating another scenario that is only slightly different is to right-click on the 
scenario and select Clone Selected Scenario(s). This will create a copy of the 
scenario that can then be renamed and modified. 

4.2 Adding Observations to Scenarios 
1. Observations can be added to scenarios either via the Risk Map or the Risk Table. 

The only exception to this is values for constants; they can only be entered via the 
Risk Table. 

 
2. You will enter the constant observations first. 

 
3. For all three makes of car, fuel price and annual mileage are going to be the same. In 

the row entitled fuel_price_const enter the value 3 in each scenario’s text box. 
Likewise, enter 10000 in all three boxes in the miles_per_year_const row. Your Risk 
Table should now look like this: 

 

 
 

Figure 25 Risk Table with constant values entered for three scenarios 
 

4. Now enter the Car Type for each scenario. Select Large in the drop-down box for 
Mercedes, select Medium for Honda and select Small for Ford. 

 
5. Similarly, enter the Reliability for each make of car. For Honda, select High and for 

Ford select Low.  
 

6. For Mercedes, you are going to enter soft evidence. Double-click on the Reliability 
entry to expand it. Enter 1 in the Medium and Low text boxes. 

 

 

Soft evidence can only be entered on the first active scenario in the Risk Table. 
To enter soft evidence on any other scenario, you need to make any other 
scenarios temporarily inactive. 

 
7. Your Risk Table should now look like the one in Figure 26. 
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Figure 26 Risk Table with constants, hard evidence and soft evidence 
 

8. Run a calculation. 
 
9. When the calculation is complete, switch to the Risk Map view. Your Risk Map should 

look like this: 
 

 
 

Figure 27 Risk Map showing three scenarios 
 

10. Observe that each Risk Graph now shows all three scenarios. Look at the Total 
Annual Cost ($) node and compare the three makes of car. Move your mouse over 
the lines to view the summary information. Given the information we have entered so 
far, the model tells us that owning a Mercedes will have the highest annual cost 
(mean = $2286.50) followed by Honda (mean = $1344.90). Ford is the cheapest 
(mean = $1017.30).  

 
11. The narrower a distribution, the more confident we are that the mean represents the 

“true” value of the node. Notice that the distribution for Ford is the narrowest; we can 
be fairly confident that the actual annual cost of owning a Ford will be close to 
$1017.30. Conversely, the Mercedes distribution shows the greatest spread; the 
actual annual cost of owning a Mercedes could be significantly higher or lower than 
$2286.50.  

 
12. Look at the two nodes Car Type and Reliability. Remember that we entered 

observations for these nodes in the Risk Table. Each scenario is represented by a 
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label sitting on top of the node. In the case of Reliability, notice that the label for the 
Mercedes scenario says Soft Evidence and that this scenario has two corresponding 
bars on the Risk Graph. The two bars show the information that you entered; namely, 
that a Mercedes could just as likely have high or medium reliability. 

 
13. Imagine now that, having read a glowing review in a car magazine, you believe the 

reliability of Mercedes cars to be high. Right-click on the Reliability node and select 
Enter Observation → Mercedes → High.  

 
14. Run a calculation. 

 
15. Observe how the mean total annual cost of owning a Mercedes has decreased 

slightly to $2156.10. Despite the improved reliability, however, owning a Mercedes is 
still likely to cost more than owning either of the other two cars. 

 
16. Return to the Risk Table view and try entering different values for Fuel price $ (gallon) 

and Miles per Year. Remember to run a calculation when you have finished making 
your changes. Return to the Risk Map to view the updated Risk Graphs (or expand 
the Risk Explorer so that you can see the graphs while you are still in the Risk Table 
view). Note what effects the changes have had on the Total Annual Cost ($) node. 

 
17. Try entering different constant values for each scenario. For example, you might 

decide that, if you owned a Ford, you would drive it a lot more than if you owned a 
Honda and that, if you owned a Honda, you might drive it slightly more than you 
would drive a Mercedes. You would represent this information by specifying different 
values for miles_per_year_const (18000 for Ford, 10000 for Honda and 8000 for 
Mercedes, say). Under these circumstances, a Ford costs the most to run.  
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5 Next Steps 
This tutorial has shown you step-by-step how to build a reasonably complex model using 
AgenaRisk. There are, however, still many ways of using the tool that have not been covered. 
In order to learn more about these different uses you should you should work through the 
more advanced tutorial, Advanced Modelling with AgenaRisk, and explore the range of well-
documented example models that come with the tool. 
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